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VS2DTI -- A Graphical User Interface for the Variably Saturated Flow and 
Solute Transport Computer Program VS2DT

By Paul A. Hsieh, William L. Wingle, and Richard W. Healy

ABSTRACT
VS2DTI is a graphical user interface for the U.S. Geological Survey’s variably satura

ground-water flow and solute transport computer program, VS2DT. VS2DTI provides a wind
based modeling environment that allows the user to generate input data sets, run the VS2D
program, and display simulation results. Computer program VS2DT solves the finite differe
approximations to Richard’s equation for flow and the advection-dispersion equation for 
transport. Problems can be simulated in one or two dimensions using cartesian or radial 
coordinate systems. VS2DTI consists of a preprocessor, the VS2DT program, and a 
postprocessor. The preprocessor allows the user to view and edit spatially varying input dat
design and model domain boundaries can be changed independently of hydraulic paramete
feature greatly facilitates resizing and refinement of the model grid. There are several optio
setting time-varying boundary conditions. Numerical values can be entered into tables and 
options can be selected from menus. The postprocessor can display contours of simulated
pressure head, moisture content, saturation, or concentration for each time step, thus crea
simple animation of model results. This report provides an overview of the features and 
capabilities for VSDTI. The current version of the software contains an on-line help manua
gives detailed instructions and a tutorial on how to use the software.

 INTRODUCTION

VS2DTI is a graphical user interface for simulating water and solute transport throug
variably saturated porous media with the computer program VS2DT (Healy, 1990; Lappala
others, 1987). The interface consists of a preprocessor and a postprocessor. The user sele
simulation options and enters the input data required by the model in the preprocessor. VS
can then be executed from within the interface, and results, in terms of contour plots of pre
heads or other variables, can be displayed as functions of time in the postprocessor. 

VS2DT is a finite-difference model for simulating water and solute movement throug
variably saturated porous media. It has been applied in a variety of field studies (for examp
McCord and others, 1997; and Halford, 1997). The approximating equations that it solves a
based on Richard’s equation for flow and the advection-dispersion equation for transport. T
model can analyze problems in one or two dimensions using either cartesian or radial coor
systems. Several boundary conditions that are specific to flow under unsaturated condition
available, including infiltration with ponding, evaporation, plant transpiration, and seepage f
Solute transport options include first-order decay, adsorption, and ion exchange. The progr
written in standard Fortran 77. 

In the VS2DTI preprocessor, options are selected from pull-down menus and variou
buttons, check boxes, and text fields. Numerical data that are independent of space in the 
simulation are entered into tables. Data that vary spatially are entered and edited graphical
tools that are commonly found in other graphical user interfaces for hydrologic models. The
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preprocessor creates an ASCII format input file that is passed to VS2DT. Once all required
have been entered, the user can run VS2DT within the graphical user interface and display
in the postprocessor. The postprocessor graphically displays results as they change over th
duration of the simulation time. Overall errors in fluid and solute mass balance are also disp
                                                                                          2



sed 
Spatial 
oints, 
 for file 
al. 
 

ect to 
Figure 1. -- Main window of VS2DTI preprocessor.

The "Drawing Area" is where graphic input are viewed. The "Active Data" selector is u
to switch among different types of spatial data to be entered or edited on the drawing area. 
data include the model domain, textural map, initial and boundary conditions, observation p
grid, and site map. The toolbar contains buttons for data entry and editing. Menus are used
management, displaying and editing data, selecting options, and accessing the help manu
Horizontal and vertical rulers show the coordinate axes system. The cursor coordinates are
displayed in the lower left corner of the window and give the position of the cursor with resp
the model origin. These features are explained more fully in the following sections.
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Pull-Down Menus

Five pull-down menus are located at the top of the main window: "File", "Edit", 
"Options", "Show", and "Help" (fig. 1).

File

The "File" pull-down menu allows the selection of a new ("New") or existing ("Open") 
as the VS2DTI input data file. It also allows the current input data file to be saved ("Save") 
renamed ("Save As"). Note that the input data file to VS2DTI is not the same as the input da
to VS2DT. The latter is an ASCII file generated by the interface based on the simulation se
This file is automatically generated when the postprocessor is invoked, but it can also be sa
a user-specified directory by using the "Export" menu item. Exported data can be used to r
VS2DT outside of VS2DTI. (Note that the current version of this software does not allow exi
VS2DT input data sets to be imported into the interface.) Selection of the "Print" menu item 
whatever is currently displayed in the Drawing Area. The "Exit" item in the menu terminates
program.

Edit

The "Edit" pull-down menu allows selection of several common editing tools, such a
"Undo", "Redo", and "Delete". The actual items that appear in this menu depend on how th
"Active Data" is set and are discussed in the subsequent section on Spatial Data Types.

Options

The "Options" pull-down menu has two items:  "Drawing..." and "Model...". Selection
"Drawing..." opens the Drawing Options dialog box which is used to set the size and scales o
the drawing area as well as the location of the origin and ruler units. Selection of the "Mode
item opens the Model Options dialog box. This box contains five or seven, if transport is 
simulated, tabbed panels within which the user selects and sets various options.

The Basic panel allows selection of length, time, and mass units. It is recommended that 
the user set these units as the first step in constructing a simulation and that they never be
changed. Any set of units can be used, but consistency must be maintained in using those
when entering values for hydraulic and transport properties (such as hydraulic conductivity
boundary conditions. If units are changed after data have been entered, then the user mus
the affected data. VS2DTI does not automatically convert data to different units. The Basic panel 
also allows selection of radial coordinates (as opposed to cartesian coordinates) and simulation of 
solute transport, evaporation, and plant transpiration.

The Flow panel allows three options for setting initial conditions for the flow equation:  
1) Equilibrium profile - the initial pressure head equals negative elevation head above a wat
table, 2) Pressure head - as input by the user, and 3) Moisture content - as input by the user. 
(Selection of actual values for initial conditions is discussed in the section on Initial Hydrau
Conditions under Entering Spatial Data.) In this panel the user can also select the method 
calculating intercell relative hydraulic conductivity. Arithmetic mean is the preferred method, but
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users may also select geometric mean or upstream weighting. Four methods are allowed for 
representing hydraulic characteristic function: the van Genuchten model, the Haverkamp model, 
the Brooks-Corey model, and tabular data. Details on these methods are given in Lappala and
others (1987) and in the on-line help manual in VS2DTI.

The Transport panel appears only if the Simulate transport option was selected on the 
Basic panel. On this panel there are two options each for space and time differencing. Centered in 
space differencing is preferred; backward in space is less accurate, but can be used to avoid 
oscillations when coarse spacing is used. Centered in time differencing (Crank-Nicholson 
scheme) is more accurate than backward in time (fully implicit scheme) but can cause oscillations
There are several options for adsorption and ion exchange. Users may select one and only
these options. Details on the available adsorption isotherms and ion exchange reactions as
definitions for the required parameters are contained in Healy (1990) and in the on-line hel
manual in VS2DTI.

The Solver Panel allows entry of values for parameters that affect the iterative matrix
solver in VS2DT. The Relaxation parameter should generally be in the range of 0.4 to 1.2. The
Minimum and Maximum number of iterations control the range in number of iterations that the
solver will attempt. If convergence is not achieved in the allowed number, then the solution 
restarted for the time step with a reduced time-step size. If convergence is not achieved afte
consecutive time-step reductions, the simulation is considered to have reached convergenc
failure. When this occurs, the action taken by VS2DT depends on whether the user selecte
option to Stop simulation at convergence failure. If so, then the program is terminated. If not, the
the simulation proceeds to the next time step after printing a warning. It is recommended th
Stop simulation at convergence failure option be selected. The simulation will also halt if the 
Maximum number of time steps is reached. Closure criteria for head and concentration are used 
by the matrix solver to test for convergence. If the maximum change in head or concentrati
any node between successive time steps is less than the criterion, then convergence is ass
general, as these criteria are decreased, the accuracy of results is improved and the compu
effort is increased.

The Output panel controls the writing of VS2DT output files. Specific information on 
these files is contained in the Files section of this report. There are five Output Variables that may 
be selected. If selected, then values for these variables at every node will be printed to the 
output file at selected Output Times. (Note that if the Print Result option of the Recharge Period 
window is selected, these values will be printed for every time step in the recharge period.)Mass 
Balance Output may be printed to the main output file at selected Output Times or after every time 
step. Output Times can be selected to coincide with regular time intervals or they can be set b
user.

The Fluid Balance panel allows selection of any combination of fluid balance 
components to be written to the auxiliary output file, "file09.out". For each selected compon
three entries are written: total for simulation, total for time step, and rate for time step.

The Solute Balance panel appears only when the Simulate transport option is selected on 
the Basic panel. It allows selection of solute mass balance components in exactly the same
manner as described for the Fluid Balance panel.
                                                                                          5
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The "Show" pull-down menu allows the user to select spatial data to display in the 
Drawing Area. One or more of these data types can be displayed at a time. The user may 
select display of the "Postprocessor" and three windows that specify attributes of the spatia
the Textural Class window, the Evapotranspiration window, and the Recharge window. The 
Textural Class window is linked to the Textural Map spatial data type and is discussed in th
section. Similarly, the Recharge Period window is linked to the Boundary Conditions spatial da
type and is discussed in that section. The Evapotranspiration window is presented in the 
following paragraph. Selecting the "Postprocessor" opens the Postprocessor window, which is 
discussed in a later section.

The Evapotranspiration window contains a table of parameters for each 
evapotranspiration period. It can be displayed only if either or both of the Simulate evaporation or 
Simulate transpiration options are selected on the Basic Model Options panel. The columns of 
the table are divided into two tabbed panels - one for evaporation, the other for plant transpi
The user may enter the evapotranspiration (ET) period length, add new ET periods, or edit
parameters in existing ET periods.

Help

The "Help" pull-down menu has two items: "Contents..." and "About...". When 
"Contents..." is selected, an HTML browser window is opened to the table of contents of th
line help manual. This manual contains extensive information on how to use VS2DTI. Ther
manual pages for all windows and spatial data types. The manual is organized so that the 
contents can be used to navigate to any desired page. The order in which material is prese
the table of contents is designed to guide new users through all steps of creating a new sim
There is also a tutorial that new users will find useful before constructing their own simulati
The "About..." item displays the version number of VS2DTI. 

Entering Spatial Data

Eight different types of spatial data are discussed in the following paragraphs. To en
edit a particular data type, it must be selected as the "Active Data" in the main window (fig.

Domain

The domain is the region in which fluid flow and solute transport is simulated. The 
domain is surrounded by the exterior boundary. Regions inside the domain may be exclude
interior boundaries. Exterior and interior boundaries are represented by polygons with an 
unlimited number of vertices. There are six buttons available in the toolbar. From top to bot
these buttons are used for editing (or moving) polygons, creating an exterior boundary, crea
interior boundary, adding additional vertices to a polygon, zooming in, and zooming out. Ite
available in the "Edit" pull-down menu are: "Undo", "Redo", "Select All", and "Delete".
                                                                                          6
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Textural Map

The textural map shows the spatial distribution of textural class zones. Each zone 
represents a region in which flow and transport properties are assumed to be uniform. The
properties for the textural classes are entered in the Textural Class window. Zones are 
represented by polygons that are drawn by the user. There are six buttons, once the doma
defined (otherwise five buttons), on the toolbar. From top to bottom, these buttons are used
selecting, moving, or reshaping a zone, adding a zone, adding a vertex to an existing zone
viewing a discretized version of the map, zooming in, and zooming out. Items under the "E
pull-down menu include "Select All", "Delete", "Bring to Front", and "Send to Back". These 
two items are available because zones may overlap one another. When portions of the dom
covered by more than one textural class zone, the overlying (or topmost) class is used. Any
portion of the domain that is not covered by a textural zone is assigned to the "inactive" tex
class. 

When the textural map is selected as the "Active Data", the Textural Class window is 
displayed (fig. 2). The window may also by displayed through the "Show" pull-down menu. 
window contains the table of parameter values for each textural class. The table is divided 
two tabbed panels, one for flow and one for transport, if transport is simulated. The parame
that appear in the table are dependent on the options that were selected by the user in theModel 
Options dialog box (such as which representation is used for the hydraulic characteristic fun
and whether adsorption is to be simulated). The parameters are defined in the on-line help

 

Figure 2. -- Textural Class window of VS2DTI.

Cells in the table are not directly editable. Instead, the buttons below the table may b
to add, edit, or delete a textural class. When the Textural Class window is opened for the first 
time, it will contain a single class named "inactive". This is the default class and represents
regions of the domain that are impermeable (that is, water will not flow through zones that 
assigned to this class). The parameters in this class are not editable. Before delineating a 
class zone on the "Drawing Area", the texture class must be added the table. To do so, the
must click the "Add" button. This will display the Add Textural Class dialog box. The user then
selects a color for the new class and enters the required flow and transport parameters. Def
                                                                                          7
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of all parameters are contained in Healy (1990) and in the on-line help manual. If the van 
Genuchten functions were selected to represent the hydraulic characteristics, the user has
option of selecting hydraulic parameters from a catalog of values for generic soil types. 
References for these parameter values are contained in Lappala and others (1987) and Ca
Parrish (1988). Zones for any texture class can be delineated on the "Drawing Area" by 
highlighting the row of the desired texture class and using drawing tools available on the to
Parameter values for existing textural classes may be edited by highlighting the appropriate
and selecting the "Edit" button. This will open the Edit Textural Class dialog box and allow the 
user to change any values.

Initial Hydraulic Condition

Initial hydraulic conditions may be specified in terms of pressure head, moisture con
or an equilibrium profile. This selection is made in the Flow panel of the Model Options dialog 
box. The spatial data type for the initial condition depends on this selection and is titled "In
Pressure Head", "Initial Moisture Content", or "Initial Equilibrium Profile". When initial 
conditions are specified in terms of pressure head or moisture content, the user may draw c
lines of equal value across the model domain. The buttons on the toolbar allow the user to 
or edit contour lines, add closed or open contours, add a vertex to a contour line, display th
discretized initial conditions, view labels on the contour lines, and zoom in and out. Options
available in the "Edit" pull-down menu include: "Undo", "Redo", "Select All", "Delete", "Conto
Value..." (to edit contour values), "Interpolation Method..." (for selecting an alternative 
interpolation method), and "Color Scale" (for modifying the color scale).

If an initial equilibrium profile is selected, pressure heads are set equal to the negati
elevation head above a water table. The user must specify the z coordinate of the water table. The 
user may also replace the upper part of the equilibrium profile by a constant Minimum pressure 
head. In a new simulation, the user sets these values after opening the Initial Equilibrium Profile  
dialog box when "Initial Equilibrium Profile" is the "Active Data". This is done by clicking on t
top most button of the toolbar or through the "Edit" pull-down menu. The region from the w
table downward (the saturated zone) is colored blue. A red line is drawn at the z coordinate
the negative of elevation head above the water table equals the minimum pressure head. P
head below the red line is hydrostatic (uniform total head). Pressure head above the red lin
equal to the minimum pressure head. The depth of the water table and the minimum pressu
may be modified by reopening the dialog box or by simply clicking and dragging the water t
or red line.

Initial Concentration

These data are displayed only if solute transport is being simulated. Initial values for
concentration are entered with contour lines in the same manner described for initial press
heads and moisture contents. 
                                                                                          8



is a 
harge 
us any 
ndary. 
 

s. 

is is 
ry 
 

 to a 
ot 
rge 
om of 
s 
ly 

charge 

th flow 
ndary 
terest 
cts 
ng the 
hted in 

 
rs may 
nce a 
ther 

 in 
the 
er 

 the 

isture 
ep. 
he 
n for 

" pull-
Boundary Conditions

Boundary conditions must be specified for each recharge period. A recharge period 
time span during which boundary conditions and stresses remain unchanged. For each rec
period, boundary conditions must be assigned to each segment of the exterior boundary pl
interior boundaries. A segment is the straight line connecting two adjacent vertices on a bou
A boundary condition applies to the entire segment. To vary the boundary condition along a
segment, it is necessary to insert vertices on the segment to subdivide it into smaller piece
Different boundary conditions can then be specified on the subdivided pieces. 

Before boundary conditions can be assigned, recharge periods must be created. Th
accomplished with the Recharge Period window which is automatically opened when "Bounda
Condition" is the "Active Data". This window can also be opened from the "Show" pull-down
menu. The window contains a table of recharge period parameters. Each row corresponds
different recharge period. Columns contain parameter values. The values in the table are n
directly editable. To add a new recharge period, the user must click on the row of the recha
period that the new period is to follow. Then the "Add" button should be selected at the bott
the table. This will open the Add Recharge Period dialog box. The recharge period parameter
can then be entered. Definitions and descriptions of these parameters are contained in Hea
(1990) and in the on-line help manual. If the user wishes to modify parameter values, the re
period row must be selected and the "Edit" button clicked. This will open the Edit Recharge 
Period dialog box.

Once recharge periods have been created, boundary conditions can be assigned. Bo
and transport boundary conditions must be specified. To specify boundary conditions, "Bou
Conditions" must be selected as the "Active Data". Next, the row of the recharge period of in
must be selected in the Recharge Period window. To assign boundary conditions, the user sele
a boundary segment and clicks on it. Multiple boundary segments can be selected by holdi
mouse button down and dragging the mouse across them. Selected segments will be highlig
gray. Next, the user opens the BC for Recharge Period dialog box by clicking the "BC" button on
the toolbar. In this box, the desired flow and transport boundary types may be selected. Use
also select the option to set this boundary condition for all subsequent recharge periods. O
boundary condition is selected, it is colored according to the key displayed on the toolbar. O
buttons on the toolbar allow for display of labels of boundary condition values and zooming
and out. Items available in the "Edit" pull down menu include "Copy All To ..." which allows 
user to copy all boundary conditions from one recharge period to another period, and "Corn
Policy..." which allows the user to determine how boundary conditions should be applied at
vertices where boundary segments are joined. 

Observation Points

Observation points denote locations where simulated total head, pressure head, mo
content, saturation, and concentration are written to output file, "file11.out", at every time st
Observation points can be added when "Observation Points" is the "Active Data" by using t
second button from the top of the toolbar. The user then simply clicks on the desired locatio
the observation point. Points can be moved by using the top most button. Items in the "Edit
down menu include "Select All" and "Delete". 
                                                                                          9
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The grid consists of vertical and horizontal grid lines forming a rectangular array of c
To lay out the grid, the user selects "Grid" as the "Active Data". The grid may be edited on 
"Drawing Area" or on the Grid  window which may be opened by the button on the toolbar or
through the "Edit" pull-down menu. 

A uniform grid containing columns of equal widths and rows of equal heights can be
created by selecting "Uniform Grid..." from the "Edit" pull-down menu. This opens the Uniform 
Grid  dialog box, into which the user may enter values for the number of columns and rows. 
Clicking "OK" then causes the grid to be displayed. Buttons on the toolbar permit the user 
move the entire grid, move individual grid lines, add new vertical or horizontal lines, show or
the Grid  window, display the "Drawing Area" as it will be discretized, and zoom in and out. 

The Grid  window can also be used to add additional vertical or horizontal grid lines. 
Additional items that can be selected from the "Edit" pull-down menu include "Subdivide..."
adding additional horizontal or vertical grid lines, "Select All..." for selecting all vertical or 
horizontal lines, and "Delete" for deleting grid lines.

Site Map

As an option, the user may load a site map in a "gif" or "jpg" graphics file. Such a ma
although not editable, could be used to guide the drawing of graphical data. To load a map
user must set "Site Map" as the "Active Data" and then select the third button from the top 
toolbar. This opens the Load Site Map dialog box, which allows the user to select the desired 
graphics file. The top most button on the toolbar can be used to move or resize the site ma
next button allows the user to stretch or compress the map in a manner that keeps one poin
This feature is useful for aligning the site map axes system with the rulers. Further details f
resizing the site map are contained in the on-line help manual. The other buttons allow zoom
and out and bringing the map to the front or sending it to the back. 

POSTPROCESSOR

The Postprocessor window contains tools to control the simulation and a display area 
resembles the "Drawing Area" of the preprocessor. Simulation results are shown in the disp
area as contours plotted across the model domain. The postprocessor is interfaced with th
numerical model VS2DT in such a way that as the model runs, the simulated pressure hea
moisture content, saturation, or concentration are displayed for each time step, thus creatin
simple animation of model results. The speed of the animation depends on the computatio
needed for each time step. Overall errors in fluid and solute balances are also displayed. 

Figure 3 shows a example of the Postprocessor window at the conclusion of a simulation
Contours of concentration are displayed along with a color scale. Below the contour plot is
information on simulation time and mass balance errors. There are two pull-down menus a
top of the window: "Action" and "Option". Menu items under "Action" are "Run", "Stop", 
"Reset", "Print...", and "Done". If "Run" is selected, the model computes the solution for the
time step and continues until the entire simulation is completed. The "Run" button immedia
below the "Action" menu performs the same function. Selecting "Stop" halts execution of th
model and allows the user to print out the contour plot at the stopped time. The "Stop" butt
                                                                                          10
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performs the same function. "Reset" moves the clock back to the beginning of the simulatio
that the simulation can be restarted. If "Print..." is selected, the screen as it appears at the 
time is printed. Selecting "Done" closes the Postprocessor window.

Figure 3. -- Postprocessor window of VS2DTI.

Menu items under "Option" include "Color Scale...", "Speed...", "Zoom in", and "Zoo
out". If "Color Scale..." is selected, the Color Scale dialog box is opened. In this dialog box, the
user can set the upper and lower contour limits and the contour interval. Selecting "Speed.
opens the Animation Speed dialog box in which the user can enter a time-delay interval that 
insures that each time step in the model will be executed no faster than that increment. "Zo
and "Zoom out" perform the same functions as in the preprocessor.

The user can select which output variable to display (pressure head, moisture content, 
saturation, or concentration) in the left drop-down list box above the display area. The right dr
down list box allows the user to switch between Cell and Contour displays. When Cell is selected, 
the display consists of active cells each colored uniformly according to the color scale on th
right. When Contour is selected, the display consists of contours with the regions between 
contours filled with a uniform color according to the color scale on the right. 
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Display of mass balance errors are included in the postprocessor to give an indicatio
the accuracy with which the finite difference matrix equations are being solved by the mode
Mass balance error alone, however, may not be a valid indicator of simulation accuracy. A s
mass balance error may not signify a high degree of accuracy, but a large mass balance er
usually indicative of low accuracy. As an example, backward differencing in the solution of 
transport equation is mass conservative and can produce low mass balance errors, but for 
problems involving sharp concentration fronts, that scheme will not be highly accurate beca
the introduction of artificial numerical dispersion.

FILES

The preprocessor creates an ASCII format file for input to the VS2DT model based o
data that have been entered by the user. ASCII output files are then generated by VS2DT. 
files contain information in addition to that displayed in the postprocessor. Only brief informa
on these files is given here. The user is referred to Lappala and others (1987) and Healy (19
additional details on the VS2DT input and output files. 

Input 
An input file for VS2DT is created whenever the user exports data from the preproce

The user can give this file any name. An input file, "vs2dt.dat", is also created every time th
Postprocessor window is shown. This file is placed in the current working directory (the 
directory where the VS2DTI input file is located). These input files are identical in format w
that described in Healy (1990) with the following two exceptions. 

A new line of input follows line B-5 and contains two variables: "hydraulicFunctionTyp
which takes on a value of 1 for use of the van Genuchten functions, 2 for Haverkamp, 3 for
Brooks-Corey, and 4 for tabular data; and "adsorptionType", which takes on a value of 1 for 
a linear isotherm, 2 for a Langmuir isotherm, 3 for a Freundlich isotherm, 4 for monovalent-
monovalent cation exchange, 5 for monovalent-divalent exchange, 6 for divalent-monovale
exchange, and 7 for divalent-divalent exchange.

The other modification to the input file is that free format input is now allowed for 
importing initial conditions on input lines B-13 and B-25. Because of these modifications, 
previous versions of VS2DT will not read input files created with the preprocessor. A versio
VS2DT that can be used with these input files outside of VS2DTI is included in the downloa
package.

Output 
There are five ASCII output files that are created by VS2DT in the current working 

directory. These are named "vs2dt.out" (the main output file), "file07.out", "file08.out", 
"file09.out", and "file11.out". These files are identical to those described in Healy (1990). Th
user can change the names of files to be created by VS2DTI by using a text editor to edit th
"vs2dt.fil" that is in the that directory. That file contains names for the input and output files.

HOW TO OBTAIN AND INSTALL VS2DTI
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The software described in this report and an electronic version of this manual, along
instructions for downloading and installing the software, can be obtained from the web site http://
water.usgs.gov/software/. Many other hydrologic computer programs are available at this site
Future updates to VS2DTI are planned to provide additional functionality in the postproces
The latest version of VS2DTI and a discussion of recent updates will also be available at th

Additional copies of this report and the reports by Healy (1990) and Lappala and others (198
available from:

U.S. Geological Survey
Branch of Information Services
Box 25286
Denver, CO 80225-0286

For additional information, write to the address on page ii  of this report.
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